
 

 

 

 

 

 

 

 

Dream Weaver 
 

 

Prepared by 

Mr. D. Karthik, 

Asst. Professor, 

PG & Research Department of computer science, 

Government Arts college, Ariyalur 

 

 

 

 

 



INTERNET: 

The internet is a global network of computers that works much like the postal system, 

only at sub-second speeds. 

 The Internet is a global wide area network that connects computer systems across the 

world. It includes several high-bandwidth data lines that comprise the Internet "backbone." 

These lines are connected to major Internet hubs that distribute data to other locations, such 

as web servers and ISPs. 

 Web – a collection of billions of webpages that you can view with a web browser 

 Email – the most common method of sending and receiving messages online 

 Social media – websites and apps that allow people to share comments, photos, and 

videos 

 Online gaming – games that allow people to play with and against each other over the 

Internet 

 Software updates – operating system and application updates can 

typically downloaded from the Internet 

 

W3C: 

Stands for "World Wide Web Consortium." The W3C is an international community that includes 

a full-time staff, industry experts, and several member organizations. These groups work together 

to develop standards for the World Wide Web. 

 

The mission of the W3C is to lead the Web to its full potential by developing 

relevant protocols and guidelines. This is achieved primarily by creating and publishing Web 

standards. By adopting the Web standards created by the W3C, hardware manufacturers 

and software developers can ensure their equipment and programs work with the latest Web 

technologies. For example, most Web browsers incorporate several W3C standards, which allows 

them to interpret the latest versions of HTML and CSS code. When browsers conform to the W3C 

standards, it also helps Web pages appear consistent across different browsers. 

  

Besides HTML and CSS standards, the W3C also provides standards for Web graphics 

(such as PNG images), as well as audio and video on the Web. The organization also develops 

standards for Web applications, Web scripting, and dynamic content. Additionally, the W3C 

provides privacy and security guidelines that websites should follow. 

 

The World Wide Web Consortium has played a major role in the development of the Web 

since it was founded in 1994. As Web technologies continue to evolve, the W3C continues to 

publish new standards. For example, many of the technologies included in Web 2.0 websites are 

based on standards developed by the W3C. To learn more about the W3C and the current standards 

published by the organization, visit the W3C website. 
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URL: 

Stands for "Uniform Resource Locator." A URL is the address of a 

specific webpage or file on the Internet.  

 

1. http:// – the URL prefix, which specifies the protocol used to access the location 

2. techterms.com – the server name or IP address of the server 

3. /definition/url – the path to the directory or file 

While all website URLs begin with "http," several other prefixes exist. Below is a list of various 

URL prefixes: 

 http – a webpage, website directory, or other file available over HTTP 

 ftp – a file or directory of files available to download from an FTP server 

 news – a discussion located within a specific newsgroup 

 telnet – a Unix-based computer system that supports remote client connections 

 gopher – a document or menu located on a gopher server 

 wais - a document or search results from a WAIS database 

 mailto - an email address (often used to redirect browsers to an email client) 

 file - a file located on a local storage device (though not technically a URL because it 

does not refer to an Internet-based location) 

 HTML | <noframes> Tag 

 

The <noframes> tag is the backup for those browsers that does not support frames. This tag can 

contains all the element that can be placed in <body> tag. It is used to create link with the non-

frame set version of any website where you want to display a message to the user. 

This <noframes> tag is not supported in HTML5. 

Syntax: 
<noframes> Statement for the user </noframes> 

Note: <noframes> tag placed inside of <frameset> tag. 

Below example illustrate the <noframes> tag: 

Example: 

filter_none 

edit 

play_arrow 

brightness_4 

<html>  

   

<head>  

    <title>noframes tag</title>  

    <style>  

        frame {  

            text-align: center;  

        }  

    </style>  

</head>  
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<!-- frameset attribute starts here --> 

<frameset cols="30%, 40%, 30%">  

    <frame src="frame_a.htm" />  

    <frame src="frame_b.htm" />  

    <frame src="frame_c.htm" />  

    <noframes>  

        Sorry, your browser does not handle frames!  

    </noframes>  

</frameset>  

<!-- frameset attribute ends here --> 

   

</html>  

Output: 

    If browsers supported: 

 

 

 
    If browsers does not supported: 

 

   



Supported Browsers: The browsers supported by HTML <noframes> tag are listed below: 

 Google Chrome 

 Internet Explorer 

 Firefox 

 Safari 

 Opera 

 

 

 

 Advantages of Using Frames 

1. One of the most beneficial feature of frames is it lets the user to have multiple pages in the 

same browser. 

 

2. Using frames we can keep one part of the page static while changing the other parts of the page. 

 

3. If we create a top frame we can use it as a header i.e, as that page is static it acts like an include 

page. 

 

4. Frames can be used to reduce server load, as there is no need to reload all the pages when ever 

a new page is visited. 

 

 

Web design: 

 

Web design is the process of creating websites. It encompasses several different aspects, 

including webpage layout, content production, and graphic design. While the terms web design 

and web development are often used interchangeably, web design is technically a subset of the 

broader category of web development. 

Websites are created using a markup language called HTML. Web designers build 

webpages using HTML tags that define the content and metadata of each page. The layout and 

appearance of the elements within a webpage are typically defined using CSS, or cascading style 

sheets. Therefore, most websites include a combination of HTML and CSS that defines how each 

page will appear in a browser. 

   

Some web designers prefer to hand code pages (typing HTML and CSS from scratch), 

while others use a "WYSIWYG" editor like Adobe Dreamweaver. This type of editor provides a 

visual interface for designing the webpage layout and the software automatically generates the 

corresponding HTML and CSS code. Another popular way to design websites is with a content 

management system like WordPress or Joomla. These services provide different 

website templates that can be used as a starting point for a new website. Webmasters can then add 

content and customize the layout using a web-based interface. 

While HTML and CSS are used to design the look and feel of a website, images must be 

created separately. Therefore, graphic design may overlap with web design, since graphic 

designers often create images for use on the Web. Some graphics programs like Adobe Photoshop 
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even include a "Save for Web…" option that provides an easy way to export images in a format 

optimized for web publishing. 

 

 

sing Code Snippets 

Code snippets are reusable blocks of code that can be inserted in a page. Dreamweaver supplies a 

collection of code snippets on the Snippets panel (Shift-F9), including blocks of HTML and 

JavaScript. You can also create your own code snippets and add them to the Snippets panel. 

To insert a code snippet: 

1. In Code view, place the insertion point where you want to insert the snippet. 

2. From the Window menu, choose Snippets, or press Shift-F9.  

  

 Access code snippets on the Snippets panel. 

3. Select a folder to access the snippets. For example, select the Accessible folder and then 

select the Headers folder. 

4. In the Headers folder, double-click the Text on Top snippet  

https://techterms.com/definition/web_publishing


  

 Double-click a snippet to add it to your page. 

The Text on Top header is added to your page at the insertion point  

  

    The Text on Top code snippet in the Headers folder is added at the insertion 

point. 



 

 The Snippets panel is part of the Files panel group, which also includes the Files and Assets 

panels. You can also access the Snippets panel by selecting the Snippets tab in the Files 

panel group. 

 To use JavaScript snippets, you need some basic knowledge of JavaScript to know where to 

insert the snippets. You also need to know what other tags, such as a script tag, need to be 

used with a snippet. 

To create a code snippet: 

1. On the Snippets panel, click the New Snippet button at the bottom of the panel  

  

 Click the New Snippet button at the bottom of the Snippets panel to create a new snippet. 

The Snippet dialog appears. 

2. In the Name field, enter a name for the snippet  



  

Creating a new snippet in the Snippet dialog. 

3. In the Description field, enter an optional description of the snippet. 

4. Select the Wrap Selection radio button to insert two blocks of code, one before and one 

after a tag on the page. Or select the Insert Block radio button to insert a single block of 

code. 

5. If you chose the Wrap Selection option in the previous step, enter your code in the Insert 

Before and Insert After fields  

6. If you chose Insert Block, enter your code in the Insert Code field. 



  

 Enter your code if you chose Wrap Selection in Step 4. 

7. To select the format for previewing your snippet, select the Design or Code radio button in 

the Preview Type section. 

8. Click OK to save your snippet and close the Snippets dialog. A preview of the snippet is 

displayed (in Code or Design view) on the Preview pane of the Snippets panel, directly 

above the Snippets folders  

 

 

Code snippet: 

 

To insert a code snippet: 

1. Place the insertion point where you want to insert the code snippet, or select code to wrap 

a snippet around. 

2. In the Snippets panel (Window > Snippets), double-click the snippet. 

You can also right-click (Windows) or Control-click (Macintosh) the snippet, then select 

Insert from the pop-up menu. 



To create a code snippet: 

1. In the Snippets panel, click the New Snippet icon at the bottom of the panel. 

The Snippet dialog box appears. 

2. Complete the dialog box and click OK. 

For more information, see Setting the Snippets dialog box options. 

To edit a code snippet: 

 In the Snippets panel, select a snippet and click the Edit Snippet button at the bottom of 

the panel.  

To delete a code snippet: 

 In the Snippets panel, select a snippet and click the Remove button at the bottom of the 

panel.  

To create code snippet folders and manage code snippets: 

1. In the Snippets panel, click the New Snippet Folder button at the bottom of the panel. 

2. Drag snippets to the new folder or other folders, as desired. 

To add or edit a keyboard shortcut for a snippet: 

1. In the Snippets panel, right-click (Windows) or Control-click (Macintosh) and select Edit 

Keyboard Shortcuts. 

The Keyboard Shortcuts Editor appears. 

2. In the Commands pop-up menu, select Snippets. 

A list of snippets appears. 

3. Select a snippet and assign a keyboard shortcut to it. 

For more information, see Customizing keyboard shortcuts. 

To share a snippet with other members of your team: 

1. Find the file corresponding to the snippet that you want to share in the 

Configuration/Snippets folder in the Dreamweaver application folder. 

2. Copy the snippet file to a shared folder on your computer or a network computer. 



3. Have the other members of the team copy the snippet file to their 

Configuration/Snippets folder. 

HTML: <tr> tag 

The HTML element called the <tr> tag with syntax and examples. 

Description 

The HTML <tr> tag defines a row in an HTML table. Each <tr> tag can contain one or 

more <th> tags that define header cells in the table or one or more <td> tags that define standard 

cells in the table. This tag is also commonly referred to as the <tr> element. 

Syntax 

In HTML, the syntax for the <tr> tag is: (example of a table with 2 columns and 4 rows) 

<body> 

<table> 

  <tr> 

    <th>Item</th> 

    <th>Amount</th> 

  </tr> 

  <tr> 

    <td>Grapes</td> 

    <td>$18</td> 

  </tr> 

  <tr> 

    <td>Apples</td> 

    <td>$4</td> 

  </tr> 

  <tr> 

    <td>Pears</td> 

    <td>$7</td> 

https://www.techonthenet.com/html/elements/th_tag.php
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  </tr> 

</table> 

</body> 

Sample Output 

Item Amount 

Grapes $18 

Apples $4 

Pears $7 

Attributes 

In addition to the Global Attributes, the following is a list of attributes that are specific to the 

<tr> tag: 

Attribute Description HTML Compatibility 

align 

Horizontal alignment of text in each cell within 

the row. It can be one of the following values: 

left, center, right, justify, char 

Deprecated in HTML 4.01, 

Obsolete in HTML5, use 

CSS 

bgcolor Background color of each cell within a row 

Deprecated in HTML 4.01, 

Obsolete in HTML5, use 

CSS 

char Set the character to align the cells in a column 
Deprecated in HTML 4.01, 

Obsolete in HTML5 

charoff 
Number of characters to offset column data from 

the alignment characters (in char attribute) 

Deprecated in HTML 4.01, 

Obsolete in HTML5 

valign 

Vertical alignment of text of each cell within a 

row. It can be one of the following values: 

baseline, bottom, middle, top 

Deprecated in HTML 4.01, 

Obsolete in HTML5, use 

CSS 
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Note 

 The HTML <tr> element is found in an HTML table within the <body> tag. 

 The <tr> tag is made up of one or more <th> or <td> tags. 

 The <tr> tag defines the table rows. There must be at least one row in the table. 

 The <th> tag defines the header cells in the table which are displayed as bold, center-

aligned text. 

 The <td> tag defines the standard cells in the table which are displayed as normal-weight, 

left-aligned text. 

Browser Compatibility 

The <tr> tag is compatible with the following browsers: 

 Chrome 

 Android 

 Firefox (Gecko) 

 Firefox Mobile (Gecko) 

 Internet Explorer (IE) 

 Edge Mobile 

 Opera 

 Opera Mobile 

 Safari (WebKit) 

 Safari Mobile 

HTML | frameset Tag 

 

The <frameset> tag in HTML is used to define the frameset. The <frameset> element contains one 

or more frame elements. It is used to specify the number of row and column in frameset with their 

pixel of spaces. Each element can hold a separate document. 

Note: The <frameset> tag is not supported in HTML5. 

Syntax: 
<frameset cols = "pixels|%|*"> 

Attributes: The list of frameset attributes are given below: 

 cols: The cols attribute is used to create vertical frames in web browser. This attribute is 

basically used to define the no of columns and its size inside the frameset tag. 

 rows: The rows attribute is used to create horizontal frames in web browser. This attribute 

is used to define no of rows and its size inside the frameset tag. 

 border: This attribute of frameset tag defines the width of border of each frames in pixels. 

Zero value is used for no border. 
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 frameborder: This attribute of frameset tag is used to specify whether three dimensional 

border should be displayed between the frames or not for this use two values 0 and 1, 

where 0 defines for no border and value 1 signifies for yes there will be border. 

 framespacing: This attribute of frameset tag is used to specify the amount of spacing 

between the frames in a frameset. This can take any integer value as an parameter which 

basically denotes the value in pixel. 

Below examples illustrate the <frameset> element in HTML: 

 

Example 1: 

filter_none 

edit 

play_arrow 

brightness_4 

 

<!DOCTYPE html>   

<html>   

    <head>   

        <title>frameset attribute</title>   

    </head>   

       

    <!-- frameset attribute starts here -->     

    <frameset rows = "20%, 60%, 20%">   

        <frame name = "top" src = "attr1.png" />   

        <frame name = "main" src = "gradient3.png" />   

        <frame name = "bottom" src = "col_last.png" />   

        <noframes>   

            <body>The browser you are working does not  

                                  support frames.</body>   

        </noframes>   

    </frameset>   

    <!-- frameset attribute ends here --> 

</html>                                  



 

Output: 
The above example basically used to create three horizontal frames: top, middle, and bottom using 

row attribute of frameset tag and the noframe tag is used for that browser who doesn’t support 

noframe. 

Creating a Web Page 

After you define a site, you’ll want to start building pages. Just choose File→New or press 

Ctrl+N (⌘-N on Macs) to open Dreamweaver’s New Document window . It’s a little 

overwhelming at first. You have so many options it’s hard to know where to start. Fortunately, 

when you just want to create a new HTML file, you can skip most of these options. 

 

 The New Document window lets you create nearly every type of web document under the 

sun. Dreamweaver CS6 includes a set of prepack-aged CSS layouts that use the latest web design 

techniques, including HTML5. You’ll learn more about these layouts in Chapter 10. 

To create a basic HTML file for a web page: 

1. From the left-hand list of document categories, choose Blank Page. 

The Blank Page category lets you create a new empty document—maybe a web page or 

something a bit more esoteric, like an XML file, an external JavaScript file, or one of the several 

types of server-driven pages (such as a PHP file, discussed in Chapter 21). 

 

https://www.oreilly.com/library/view/dreamweaver-cs6-the/9781449326999/ch21.html


The Fluid Grid Layout option is new in Dreamweaver CS6. It lets you create a web page that 

adapts to three browser widths: one for a phone, a tablet, and a desktop browser. You’ll learn 

how to use this feature on Adding Styles to Media Query Style Sheets. 

Both the Blank Template and “Page from Template” categories relate to Dreamweaver’s 

Template feature discussed in Chapter 19. The “Page from Sample” category lets you choose 

from several files with already-created designs. Most of the designs are old and left over from 

earlier versions of Dreamweaver, aren’t very attractive, and don’t use the best techniques 

for building a web page. However, Dreamweaver CS6 includes some starter pages for creating 

mobile-only websites. You can learn more about these on jQuery Mobile. The last category, 

Other, lets you create documents for different programming languages like ActionScript or Java. 

Unless you’re a Flash or Java programmer, you probably won’t ever need these. 

2. From the Page Type list, choose HTML. 

You can create other types of documents, too, some of which you’ll learn more about later in this 

book, such as templates, Library items, and CSS files  

Root folder.  

Local site.  

Remote site.  

 

 

 

Click Create. 

Dreamweaver opens a new, blank web page ready for you to save and title (see Figure 1-16). 
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Figure 1-16. Here’s a new blank web page. Always remember to title the page by clicking inside 

the Title field at the top of the document window (circled) and then entering a descriptive name. 

3. Choose File→Save. 

The Save As dialog box appears. You need to save the file somewhere inside your local site 

folder. You can save it inside any subfolder within the root folder as well. 

. 

4. Type a name for the file and then click Save. 

Make sure the name doesn’t contain spaces or any characters except letters, numbers, hyphens, 

and underscores, and that it ends in either .html or .htm. 

Although most operating systems let you save files with long names, spaces, and characters like 

#, $, and &, some browsers and servers have trouble interpreting anything other than letters and 

numbers. 

Furthermore, web servers rely on file extensions like .htm, .html, .gif, and .jpg to know whether a 

file is a web page, graphic, or some other type of file. Dreamweaver for Windows automatically 

adds the extension to your saved document names. But on Macs—which let you save files 

without extensions—make sure the file ends in the suffix .html when you save it. 

5. At the top of the document window, click inside the Title field and then type a name 

for the page. 

 



Every new document Dreamweaver creates has the unflattering name “Untitled Document.” If 

you do a quick search on Google for “Untitled Document,” you’ll find (at the time of this 

writing) 52,800,000 pages (that’s 25,300,000 more untitled documents than there were when the 

last edition of this book came out—obviously some people still need to pick up a copy). 

Dreamweaver probably created most of those pages. You should change this to a descriptive title 

indicating the main topic of the page, like “Directions to Cafe Soylent Green,” “About Cafe 

Soylent Green,” or “Technical Specifications for the Anodyne 3000 Indoor Lawn Mower.” Not 

only is replacing “Untitled Document” more professional, but providing a descriptive title can 

improve a web page’s ranking among search engines. 

 


